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SAFETY INSTRUCTIONS 
This chapter contains important safety 
instructions that you should follow when 
operating the instrument and when keeping it in 
storage. Read the following before any operation 
to ensure your safety and to keep the instrument 
in best condition. 

Safety Symbols 
These symbols may appear in this manual or on the instrument. 

 

 WARNING 

Warning: Identifies conditions or practices that 
could result in injury or loss of life. 

 CAUTION 

Caution: Identifies conditions or practices that 
could result in damage to the instrument or to 
other properties. 

 
DANGER: High Voltage 

 
Attention: Refer to the Manual 

 
Protective Conductor Terminal 

 
Earth (ground) Terminal 

Safety Guidelines 
 

General 
Guidelines 

 CAUTION 

 Do not place heavy objects on the instrument. 

 Avoid severe impacts or rough handlings that 
may damage the instrument. 

 Avoid discharges of static electricity onto or 
near the instrument. 

 Do not insert bare wires or metal objects into 
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the terminals. 

 Do not apply input voltage more than 42V 
peak (30Vrms) to the instrument. 

 Do not perform measurements at a power 
generating source or building installation site 
(see note below). 

 The instrument should only be disassembled 
by a qualified technician. 

 (Measurement categories) EN 61010-1:2001 specifies 

the measurement categories and their requirements 

as follows. This instrument falls under category I. 

Measurement category IV is for measurement 

performed at the source of low-voltage installation. 

Measurement category III is for measurement 

performed in the building installation. Measurement 

category II is for measurement performed on the 

circuits directly connected to the low voltage 

installation. Measurement category I is for 

measurements performed on circuits not directly 

connected to Mains. 

Power Supply 

 WARNING 

 AC Input voltage: 100 to 240V, 50/60Hz 

 The power supply voltage should not fluctuate 
more than 10%. 

 Always use the AC adaptor included in the 
package. 

 Always connect the AC adaptor to the mains 
line first, then to the instrument. 

Cleaning the 
instrument 

 Disconnect the power cord before cleaning the 
instrument. 

 Use a soft cloth dampened in a solution of mild 
detergent and water. Do not spray liquid into 
the instrument. 

 Do not use chemicals or cleaners containing 
harsh products such as benzene, toluene, 
xylene, and acetone. 

Operation 
Environment 

 Location: Indoor, no direct sunlight, dust free, 
most non-conductive pollution (see note below) 
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 Relative Humidity: < 75% 

 Altitude: < 2000m 

 Temperature: 0°C to 40°C 

 (Pollution Degree) EN 61010-1:2001 specifies the 

pollution degrees and their requirements as follows. 

This instrument falls under degree 2. 

Pollution refers to “addition of foreign matter, solid, 

liquid, or gaseous (ionized gases), that may produce a 

reduction of dielectric strength or surface resistivity”. 

Pollution degree 1: No pollution or only dry, non-

conductive pollution occurs. The pollution has no 

influence. 

Pollution degree 2: Normally only non-conductive 

pollution occurs. Occasionally, however, a temporary 

conductivity caused by condensation must be 

expected. 

Pollution degree 3: Conductive pollution occurs, or 

dry, non-conductive pollution occurs which becomes 

conductive due to condensation which is expected. In 

such conditions, equipment is normally protected 

against exposure to direct sunlight, precipitation, and 

full wind pressure, but neither temperature nor 

humidity is controlled. 

Storage 
environment 

 Location: Indoor 

 Relative Humidity: < 75%  

 Temperature: −10°C to 70°C 
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Power cord for the United Kingdom 
When using the instrument in the United Kingdom, make sure the 
power cord meets the following safety instructions. 

 

NOTE: This lead/appliance must only be wired by competent 

persons  

WARNING: THIS APPLIANCE MUST BE EARTHED 

IMPORTANT: The wires in this lead are coloured in accordance with 

the following code: 

Green/ Yellow: Earth 

 

Blue: Neutral 

Brown: Live (Phase) 

As the colours of the wires in main leads may not correspond with 
the coloured marking identified in your plug/appliance, proceed as 
follows: 

The wire which is coloured Green & Yellow must be connected to 
the Earth terminal marked with either the letter E, the earth symbol 

 or coloured Green/Green & Yellow. 

The wire which is coloured Blue must be connected to the terminal 
which is marked with the letter N or coloured Blue or Black. 

The wire which is coloured Brown must be connected to the 
terminal marked with the letter L or P or coloured Brown or Red. 

If in doubt, consult the instructions provided with the equipment 
or contact the supplier. 

This cable/appliance should be protected by a suitably rated and 
approved HBC mains fuse: refer to the rating information on the 
equipment and/or user instructions for details. As a guide, a cable 
of 0.75mm2 should be protected by a 3A or 5A fuse. Larger 
conductors would normally require 13A types, depending on the 
connection method used. 

Any exposed wiring from a cable, plug or connection that is 
engaged in a live socket is extremely hazardous. If a cable or plug is 
deemed hazardous, turn off the mains power and remove the cable, 
any fuses and fuse assemblies. All hazardous wiring must be 
immediately destroyed and replaced in accordance to the above 
standard. 
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GETTING STARTED 

This chapter gives you an overview of what the 
GDS-122 is about, what items are included in the 
package, and how the user manual is organized. 
After opening the GDS-122 package, check the 
contents referring to the Package Contents section, 
then learn the features and interface reading the 
Main Features and Front Panel and Keys Overview 
section. The Manual Overview section gives you 
an overall picture of what each chapter is about, 
helping you directly jump to the relevant 
location. 

 

 
 

Package Contents ....................................................... 8 

Main Features ............................................................. 9 

Front Panel and Keys Overview .................................. 10 

Manual Overview ....................................................... 12 
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Package Contents 
 

Carrying case 

 

GDS-122 

 

AC-DC adaptor 

 

Oscilloscope probe x 2 

 

Probe adjustment tool 

 

Multimeter test lead x 2 

 

Extension module for large 
current measurement 

 

Extension module for small 
capacitance measurement 

 

Serial data communication cable 

 

User Manual 

(this document) 

CD-ROM (PC software) 
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Main Features 
 

Oscilloscope  Dual channel 

 20MHz bandwidth 

 100MS/s real-time sampling rate 

 ≤ 17.5ns rising time 

 5ns to 5s/div horizontal scale 

 5mV to 5V/div vertical scale 

 6k memory points per channel 

 Isolated inputs between oscilloscope and 
multimeter 

 Autoset function 

 Trigger mode: Auto, Free run, Single shot, 
Edge, Video 

 2 cursors 

 5 automatic measurements 

 4 display image memories 

 Self-calibration function 

Multimeter  Volts, Amps, Ohms, Continuity, Diode, 
Capacitance measurement 

 20A maximum amplitude 

 True RMS measurement 

 Isolated inputs between oscilloscope and 
multimeter 

Common  USB interface 

 3.8 inch color LCD display, 320 x 240 resolution 

 4 hours running time Li-ion battery 

 180mm x 113mm x 40mm compact size 

 690g light weight 
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Front Panel and Keys Overview 
 

 

 
: Oscilloscope function  : Multimeter function 

AC adaptor plug Accepts the AC adaptor cord. DC 8.5V, 1500mA. 

USB port Accepts the USB cable for PC connection. 

LCD display 3.8 inch, 320 x 240 resolution, color LCD display. 

OSC OPTION key 
+ Arrow keys 

 
Sets the following parameters: vertical 
level and scale (page 21), horizontal level 
and scale (page 24), trigger level (page 24), 
and cursor position (page 41). 

MENU key + 
Up/Down keys 

 
Activates the side menu and selects the 
menu items. 

RUN/STOP key 
 

Manually turns on (run) or off (stop) the 
trigger. For details, see page 24. 

LCD 
display

F1 - F5 keys

MENU key +
Up/Down keys

RUN/STOP key
AUTOSET key
DMM/OSC key

Power 
switch

A switch

V switch

R switch

Display 
contrast 

switch

AC adaptor 
plug

USB port

mA 
terminal Oscilloscope 

CH1/CH2 
terminal

COM 
terminal

V/Ohm 
terminal

CX 
terminal

OSC OPTION key 
+ Arrow keys

DSO DMM

DSO

DSO

DSO
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: Oscilloscope function  : Multimeter function 

RUN/STOP key  Freezes (stop) or unfreezes (run) the 
measurement. 

AUTOSET key 
 

Automatically selects the horizontal scale, 
vertical scale, and trigger level according 
to the input signal. See page 17 for details. 

  Switches the measurement modes. For 
details, see page 90(current), page 
88(voltage), and page 93(impedance). 

DMM/OSC key Switches the operation mode between oscilloscope 
and multimeter. 

CH1/2 terminal 
 

Accepts the CH1 and CH2 input signal. 

CX terminal  Accepts the test leads for capacitor 
measurement. 

V/Ω terminal  Accepts the red lead for voltage, small 
capacitance, and impedance 
measurements. 

COM terminal  Accepts the black (ground) lead. 

mA terminal  Accepts the red lead for current 
measurement. 

R switch  Selects the following measurement: 
impedance (page 93), diode (page 95), 
continuity (page 96), capacitance (page 
97). 

V switch  Selects voltage measurements (page 88). 

A switch  Selects current measurements (page 90). 

Power switch Turns on or off the GDS-122 power. 

F1 – F5 keys Selects menu items which appear in the bottom of 
the display. 

Display contrast 
switch 

Selects the display contrast: Up (bright) or Down 
(dark). 

DSO DMM

DMM

DSO

DMM

DSO

DMM

DMM

DMM

DMM

DMM

DMM

DMM
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Manual Overview 
 

Overview This user manual is separated in seven chapters. If 
you want to jump start using the GDS-122, go 
directly to the Using Oscilloscope or Using 
Multimeter chapter. 

Safety 
Instructions 

The Safety Instructions gives you an overview of 
important safety-related issues which you should 
be aware of before, during, and after operations. 

Getting Started 
(page 7) 

The Getting Started chapter provides you with the 
overview of the GDS-122: main features, package 
contents, front panel, and user manual (this 
section). 

Using the 
Oscilloscope 

(page 13) 

The Using the Oscilloscope chapter describes in 
detail how to use the GDS-122’s oscilloscope 
functionalities, including the PC software. The 
chapter starts with simple, basic operations 
toward more complex measurements and settings. 
If you are new to the GDS-122, start with the Basic 
Operations section. For advanced users, the Menu 
Tree / Shortcuts section shows the menu structures 
and all operations shortcuts. 

Using the 
Multimeter (page 

86) 

The Using the Multimeter chapter describes how to 
use the GDS-122’s multimeter functionalities. The 
most commonly used Voltage, Current, and 
Resistance sections are listed in the front. 

Faq 

(page 99) 

The Faq chapter lists major problems you might 
encounter during operations and how to fix or 
avoid them. Most issues are also listed in the 
relevant chapters throughout the document. 

Specifications 
(page 101) 

The GDS-122 specifications are separated in 
oscilloscope, multimeter, and general parts. 

Declaration of 
conformity (page 

105) 

The Declaration of Conformity chapter lists the 
safety and EMI/EMC standards to which the GDS-
122 conforms. 

Index 

(page 106) 

The Index chapter lists most of the keywords used 
in this manual in an alphabetical order. 
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USING THE 

OSCILLOSCOPE 
This chapter describes the oscilloscope 
functionalities in the GDS-122: setting it up and 
measuring simple waveforms, using advanced 
measurement functions, and configuring the 
system settings. The menu tree section at the end 
gives you an overview of all functionalities and a 
quick access to each of them. For the multimeter 
functionalities, see page 86. 

 

Basic Operations ....................................................... 15 
Powering up the GDS-122............................................ 15 
Connecting an Input Signal .......................................... 16 
Using the Autoset Function .......................................... 17 
Introducing the Display Contents ................................. 18 
Adjusting Waveform Scales .......................................... 18 
Adjusting Waveform Positions ...................................... 19 

Configurations .......................................................... 21 
Configuring Channel (Vertical) Settings ........................ 21 
Configuring Horizontal Settings ................................... 24 
Configuring Trigger Settings: General Settings ............. 25 
Configuring Trigger Settings: Edge Triggering ............. 28 
Configuring Trigger Settings: Video Triggering ............ 31 
Selecting the Acquisition Mode .................................... 33 
Selecting the Language ................................................ 34 
Configuring Display Settings ........................................ 34 
Viewing the System Status ........................................... 35 

Measurements .......................................................... 38 
Running Waveform Maths ............................................ 38 
Running Automatic Measurements ............................... 40 
Running time Cursor Measurements ............................ 41 
Running Voltage Cursor Measurements ........................ 42 
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Advanced Viewings .................................................... 45 
Zooming Waveforms Horizontally ................................ 45 
Viewing Waveforms in X-Y Format ............................... 46 
Viewing Signal Peaks.................................................... 47 
Viewing Noisy Signals .................................................. 48 
Viewing Variations in a Signal ...................................... 49 

Calibration ................................................................ 51 
Running the Self-calibration ........................................ 51 
Running the Probe Calibration ..................................... 52 

Saving/Recalling ........................................................ 54 
Recalling the Default Settings ...................................... 54 
Saving Waveforms ........................................................ 55 
Recalling Waveforms .................................................... 56 

Menu Tree / Operation Shortcuts ............................... 57 
Trigger ........................................................................ 57 
CH1/CH2 Setup ........................................................... 57 
Measurement Setup 1/2 .............................................. 58 
Wave Math ................................................................... 58 
Cursor Measurement ................................................... 58 
Acquisition Mode ......................................................... 59 
Time Mode................................................................... 59 
Function ...................................................................... 59 
Display ........................................................................ 59 
Wave Save .................................................................... 60 
System Status .............................................................. 60 
OSC OPTION Key .......................................................... 61 

Using the Software .................................................... 62 
Installing the Software ................................................. 63 
Modifying/Reinstalling/Uninstalling the Software......... 65 
Activating the Software and Connecting the GDS-122 .. 66 
Configuring the Screen ................................................ 70 
Viewing the Waveforms ................................................ 73 
Using the Cursor Measurements .................................. 78 
Saving Waveforms ........................................................ 80 
Recalling Waveforms .................................................... 82 
Printing out Waveforms ................................................ 83 
Accessing the Help ...................................................... 85 
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Basic Operations 
 

Operation flow The Basic Operations section describes how to set 
up the GDS-122 and observe an input signal, step-
by-step. 

1. Powering up the GDS-122 

2. Connecting an input signal 

3. Using the Autoset/ Introducing the display 

4. Adjusting the scales 

5. Adjusting the waveform position 

Advanced 
operations 

For more advanced or detailed operations, see the 
following chapters. 

 Configurations (page 21) 

 Measurements (page 38) 

 Advanced Viewings (page 45) 

 Calibrations (page 51) 

Powering up the GDS-122 
 

Pressing the 
power switch 

Press the power switch. The welcome 
screen with the corporate logo 
appears on the display. 

 

 To adjust display brightness, use the 
switch on the side: up (bright) or 
down (dark).  

Activating the 
oscilloscope 

Press any key (for example the MENU 
key) to enter the oscilloscope mode. 
See the battery level icon at the top left 
corner of the display and connect the 
power cord if the level is < 25%. 

(Example) 

 

 > 75% 

 

75% 

 

50% 

 

25% 

 

< 25% 

 

Switching the 
operation mode 

If the multimeter screen appears, 
press the DMM/OSC key and change  

MENU

DMM/OSC
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the mode to oscilloscope. 

Tilt standing the 
GDS-122 

Use the bar at the back of 
the GDS-122 to tilt stand it 
on a horizontal plane. 

 

Note If pressing the power switch does not turn on the 
GDS-122, the battery may need recharging. 
Connect the GDS-122 to the AC adaptor and 
recharge it for at least 15 minutes. 

Connecting an Input Signal 
 

1. Connecting 
the probe 

Connect the probe(s) between the DUT (Device 
Under Test) and the CH1/2 inputs on the GDS-122. 

2. Setting the 
probe 
attenuation 

To prevent excessive input voltage, we 
recommend you to set the probe attenuation level 
to the X 10 position to prevent excessive voltage. 

 

3. Setting the 
display 

magnification 

1. After attenuating the probe level by x10, you 
need to magnify the display level by x10 to 
balance the signal level. Open the CH1 or CH2 
SETUP menu by pressing the MENU key and 
using the Up/Down keys. 

 2. Select the probe attenuation level (10X) by 
pressing F3 (Probe) repeatedly. The CH1/CH2 
vertical scale indicator at the bottom left corner 
of the display changes accordingly. 
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Using the Autoset Function 
 

Overview The Autoset function automatically configures the 
following parameters according to the input 
signal. 

 CH1/CH2 on/off 

 Vertical scale/level 

 Horizontal scale/level 

 Trigger level 

Using the 
Autoset function 

Press the AUTOSET key. The input 
signal appears in the best display 
condition. 

 

Example 

 

10 X
ProbeCH2 SETUP

F3

MENU
CH1 SETUP

AUTOSET

Before After
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Introducing the Display Contents 
 

 

Trigger status  The signal is triggered 

 Waiting for trigger conditions 

 Triggering is stopped 

 

 

 

 Press the RUN/STOP key to control 
trigger on/off (run/stop).  

Adjusting Waveform Scales 
 

Selecting the 
menu 

Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 

LEFT/RIGHT – Time Base 

UP/DOWN – CH1 (or CH2) Vol  

 

 

Adjusting the 
horizontal scale 

Use the Left/Right key to change the horizontal 
scale. 

Trigger status

vertical center 
position

vertical scale

Trigger level

Frequency / 
channel off

Horizontal 
center 
position

Horizontal 
scale

Vertical 
center 
position

Trig’d

AUTO

STOP

RUN/STOP

OSC
OPTION

Horizontal scaleVertical scale
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Original 

 

 

   

Adjusting the 
vertical scale 

Use the Up/Down key to change the vertical scale. 

 
Original 

 

 

   

Adjusting Waveform Positions 
 

Selecting the 
menu 

Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 

LEFT/RIGHT – Time 

UP/DOWN – CH1 (or CH2) Zero  

 

 

Adjusting the 
horizontal 

position 

Use the Left/Right key to change the horizontal 
position. 

 

Original 

 

OSC
OPTION

Vertical 
center 

position

Horizontal 
center 

position
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Adjusting the 
vertical position 

Use the Up/Down key to change the vertical 
position. 

 
Original 
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Configurations 
 

Overview The configuration chapter describes how to 
change various GDS-122 internal parameters for 
allowing better measurement condition. 

Configuration 
items 

 Channel (vertical) settings 

 Horizontal settings 

 Trigger settings 

 Acquisition modes 

 Language 

 Display settings 

 System status (only for viewing) 

Page 21 

Page 24 

Page 24 

Page 28 

Page 34 

Page 34 

Page 35 

Configuring Channel (Vertical) Settings 
 

Overview The channel settings configure how the waveform 
appears in terms of vertical or voltage scale. 

 Position Sets the vertical position of the 
waveform. 

 Scale Sets the vertical scale (volts per 
graticule). Range: 5mV/div to 5V/div 

 CH on/off Turns the channel on or off. 

 Coupling Selects AC or DC coupling. The DC 
coupling shows all signal elements, 
while the AC coupling filters out the 
DC component from the waveform. 

 Inversion Flips the waveform upside down. 

 Magnifica
tion 

Magnifies the displayed units (does not 
magnify the real signal). The 
magnification function is useful to 
align the displayed with probe 
attenuation (page 16), especially X10. 
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Setting the 
vertical position 

1. Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 
LEFT/RIGHT – Time 
UP/DOWN – CH1 (or CH2) 
Zero 

 

 

 

 2. Use the Up/Down key to change the vertical 
position. 

 
Original 

 

 

   

Setting the 
vertical scale 

1. Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 
LEFT/RIGHT – Time Base 
UP/DOWN – CH1 (or 2) Vol  

 

 

 2. Use the Up/Down key to change the vertical 
scale. 

 
Original 

 

 

   

Turning the 
channel on/off 

1. Press the MENU key and use the Up/Down 
keys to select the CH1(CH2) SETUP menu. 

2. Press F2 (Channel) repeatedly to turn on or off 
the channel. 

OSC
OPTION

OSC
OPTION
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 Note that when using the Autoset function (page 
17), channels are automatically turned on or off. 

Selecting the 
coupling mode 

1. Press the MENU key and use the Up/Down 
keys to select the CH1(CH2) SETUP menu. 

2. Press F1 (Coupling) repeatedly to select DC or 
AC coupling. 

 

The DC coupling shows both DC and AC 
signal. 

The AC coupling only shows the AC signal. 

 DC coupling 

(center point is at the 
bottom due to DC 
offset) 

 

 AC coupling 

(center point is at the 
middle since the DC 
offset is being 
removed) 

 

Inverting the 
channel 

1. Press the MENU key and use the Up/Down 
keys to select the CH1(CH2) SETUP menu. 

2. Press F4 (Inverted) to invert the waveform. 

MENU

CH1 SETUP

CH2 SETUP

ON
Channel

OFF

F2

MENU

CH1 SETUP

CH2 SETUP

AC
Coupling

DC

F1
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 Invert off 

 

Invert on 

 

Selecting the 
magnification 

1. Press the MENU key and use the Up/Down 
keys to select the CH1 (CH2) SETUP menu. 

2. Press F3 (Probe) repeatedly to select the probe 
magnification ratio. 

 

Configuring Horizontal Settings 
 

Overview The horizontal settings configure how the 
waveform appears in terms of horizontal or time 
scale. 

 Position Sets the horizontal position of the 
waveform. 

 Scale Sets the horizontal scale (time per 
graticule). Range: 100ms/s to 10s/s 

Setting the 
horizontal 

position 

1. Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 

LEFT/RIGHT – Time 
 

MENU

CH1 SETUP

CH2 SETUP

OFF
Inverted

ON

F4

MENU

CH1 SETUP

CH2 SETUP

1 X
Probe

1000 X
100 X
10 X

F3

OSC
OPTION
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 2. Use the Left/Right key to change the horizontal 
position. 

 

Original 

 

 

   

Selecting the 
horizontal scale 

1. Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 

LEFT/RIGHT – Time Base 

 

 

 2. Use the Left/Right key to change the horizontal 
scale. 

 

 

Original 

 

 

   

Configuring Trigger Settings: General Settings 
 

Overview The trigger settings configure how the incoming 
signal is triggered. The general settings section 
describes how to start and stop triggering, adjust 
the level, and change the trigger mode. 

 For edge triggering details, see page 28. 

 For video triggering details, see page 31. 

OSC
OPTION
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 Status Shows the triggering status in the icon 
appearing in the upper right corner of 
the display. 

 Run/Stop Controls starting and stopping the 
trigger. 

 Level Adjusts the vertical and horizontal 
level on which the waveforms are 
triggered. 

Trigger status The trigger status icon is located at the top right 
corner of the display. 

  The trigger condition is met. 

  The GDS-122 is showing the input signal 
waveform regardless of trigger 
condition. Available in the Auto trigger 
mode in edge triggering (page 28). 

  The trigger condition is not met, and the 
GDS-122 is waiting for the next 
condition. Available in the Normal 
trigger mode in edge triggering (page 
28). 

  The GDS-122 is showing the input signal 
waveform regardless of trigger 
condition. The waveform is gradually 
updated from the left side of the display. 
The GDS-122 automatically switches to 
the Scan when the horizontal scale is at 
100ms/div or longer. 

  Triggering is stopped regardless of the 
trigger condition. In order to restart 
triggering, you have to press the 
RUN/STOP key again (in single trigger 
mode) or switch to another trigger mode. 

 Horizontal scale vs. trigger status 

Trig’d

AUTO

Ready

Scan

STOP
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Run/Stop Pressing the Run/Stop key once stops 
triggering at most situations and 
changes the trigger icon to STOP. 

 

 

 In the single trigger mode in edge triggering (page 
28), pressing the RUN/STOP key works as both 
activating and deactivating trigger. 

Trigger level Press the OSC OPTION key 
repeatedly until the following menu 
appears on the display. 

 

 LEFT/RIGHT – Time 
UP/DOWN – Trig 

 

 Trigger level indicators 

 

 Use the arrow keys to change the triggering 
position. 

100ms/div 5s/div5ns/div

STOP

AUTO

Trig’d

Ready

Scan

RUN/STOP

STOP

OSC
OPTION

Trigger level 
(horizontal)

Trigger level 
(vertical)
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 Pressing the Up and Down 
key together resets the 
vertical trigger level to zero. 

 

 

 Pressing the Left and Right 
key together resets the 
horizontal trigger level to 
zero. 

 

 

Configuring Trigger Settings: Edge Triggering 
 

  The edge trigger type triggers on the incoming 
signal edge. Use the edge trigger for all signals 
except for video related ones. 

 For general trigger settings, see page 25. 

 For video triggering details, see page 31. 

 To select edge triggering, follow these steps. 

1. Press the MENU key and use the Up/Down 
keys to select TRIG MODE menu. 

2. Press F1 (Type) to select the Edge trigger type. 

 

 Slope Selects the slope, rising or falling, on 
which the GDS-122 triggers the input 
signals. 

Move the trigger 
point up

Move the trigger 
point down

Move the 
trigger point 
right

Move the 
trigger point 

left

MENU TRIG MODE
Edge
TYPE

F1
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 Source Selects the signal source channel, 
CH1 or CH2. 

 Mode Selects the triggering mode, Auto 
(acquires signal continuously), 
Normal (acquires signal when trigger 
conditions are met), and Single 
(manually triggers the signal). 

 Coupling Selects the DC or AC coupling and 
rejection filters: high frequency or 
low frequency. 

Selecting the 
trigger slope 

Press F2 (Slope) repeatedly to 
select the rising or falling slope. 

 

 Example: rising edge 

 

Selecting the 
source channel 

Press F3 (Channel) repeatedly to select 
the trigger source channel, CH1 or 
CH2. The trigger channel indicator at 
the bottom right corner of the display 
changes. 

 

 

Falling
Slope

Rising

F2

Triggering pointRising edge

Trigger source 
channel

CH1
Source

CH2

F3
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Selecting the 
trigger mode 

Press F4 (Mode) repeatedly to select 
the trigger mode. The trigger status 
icon in the upper right corner of the 
display changes accordingly. For the 
overview of trigger status in general, 
see page 25.  

 Auto mode 

In the auto mode, input signals are constantly 
acquired and shown in the display regardless of 
trigger condition. 

 

 Normal mode 

In the normal mode, input signals are shown in 
the display only if the trigger condition is met. 

 

 Single mode 

In the single mode, you manually trigger by 
pressing the RUN/STOP key each time you need 
to observe the waveform. Once the waveform is 
captured, the GDS-122 stops triggering and waits 
for the next trigger command. 

 

Single
Mode

Auto
Normal

F4

100ms 5s5ns

AUTO

Trig’d ScanStatus icon when triggered

Status icon when not triggered Scan

Horizontal scale (/div)

100ms 5s5ns

Trig’d ScanStatus icon when triggered

Status icon when not triggered Scan

Horizontal scale (/div)

Ready

STOP

100ms 5s5ns

Status icon when triggered

Status icon when not triggered Scan

Horizontal scale (/div)

STOP

AUTO

Ready
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Selecting the 
coupling mode 

Press F5 (Coupling) repeatedly to select 
the trigger coupling. 

 AC: triggers only on the AC portion 
of the waveform. 

 DC: triggers on the whole waveform 
(AC + DC). 

 LF Rjc: filters out the lower 
frequency when triggering. 

 HF Rjc: filters out the higher 
frequency when triggering. 

 

Configuring Trigger Settings: Video Triggering 
 

                                                                                                                                                                                                              The video trigger type is designed to capture the 
video signal format, NTSC, PAL, or SECAM. For 
any other signal type, use the edge trigger. 

 For general trigger settings, see page 25. 

 For edge triggering details, see page 28. 

 To select edge triggering, follow these steps. 

1. Press the MENU key and use the Up/Down 
keys to select TRIG MODE menu. 

2. Press F1 (Type) to select the video trigger type. 

 

 Polarity Selects the polarity of 
synchronization signal. Normal 
means the black level is low. Invert 
means the black level is high. 

 Source Selects the signal source channel, 
CH1 or CH2. 

 Sync Selects the part of the video signal 
used for synchronization: line or 
field. 

DC
Coupling

AC
LF Rjc
HF Rjc

F5

MENU TRIG MODE
Video
TYPE

F1



     GDS-122 User Manual 

32 

Selecting the 
trigger polarity 

Press F2 (Polarity) repeatedly to select 
the polarity of synchronization signal. 

 Normal: the black level is low. 

 Inverted: the black level is high.  

Selecting the 
source channel 

Press F3 (Channel) repeatedly to select 
the trigger source channel, CH1 or 
CH2. The trigger channel indicator at 
the bottom right corner of the display 
changes. 

 

 

Selecting the 
sync 

Press F4 (Polarity) repeatedly to select 
the synchronization point. 

 Line: the video line is used for 
triggering. 

 Field: the video field is used for 
triggering. 

 

Example 

Video line trigger 

 

Video field trigger 

 

Normal
Polarity

Inverted

F2

Trigger source 
channel

CH1
Source

CH2

F3

Line
Sync

Field

F4
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Selecting the Acquisition Mode 
 

Overview The acquisition mode specifies how the incoming 
analog signal is digitally sampled by the GDS-122. 

 Sample The waveform data is sampled at an 
equal time interval. The sample 
mode accurately reconstructs the 
waveform, but cannot respond to 
rapid changes and sudden peaks. 

 Peak detect The maximum and minimum data 
in the sampling interval are picked 
up. The peak detect mode captures 
rapid changes and sudden peaks, 
but the waveform becomes noisy. 

 Average Multiple samples are averaged 
together. The average mode reduces 
the noise level, but the waveform 
must be repetitive. The number of 
averaging are 4, 16, 64, and 128. 

Panel operations 1. Press the MENU key and 
select the ACQU MODE 
menu using the Up/Down 
keys. 

 

 2. Select the 
acquisition mode 
from F1 (Sample) to 
F3 (Average).  

 For the Average mode, also 
press F4 (Averages) repeatedly 
to select the number of 
averaging: 4, 16, 64, or 128.  

Example Sample 

 

Peak detect 

 

Average (16) 

 

MENU ACQU MODE

Sample
Peak

Detect
Average

F1 F2 F3

16
Averages

F4
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Selecting the Language 
 

Overview You can switch the menu language between 
English and Simplified Chinese. The language 
settings affect the following areas. 

 Menu bar (right side of the display) 

 F1-F5 menu (bottom of the display) 

 System settings screen (page 35) 

Parameters English (default), Simplified Chinese 

Panel operations 1. Press the MENU key and 
select the FUNCTION menu 
using the Up/Down keys. 

 

 2. Press F3 (Language) 
repeatedly to select the 
language from English or 
Simplified Chinese. 

 

 For other menu items, see the following. 

F1 (Recall factory): factory settings (page 54) 

F2 (Do Self Cal): self-calibration (page 51) 

Note Recalling the factory settings (Function menu → 
F1) does not change the language selection. 

Configuring Display Settings 
 

Overview The display settings configure how the waveforms 
are drawn in the display. 

 vector drawing The vector drawing mode shows 
the waveform as a smooth line, 
connecting each data point. 

 dot drawing The dot drawing mode shows the 
waveform as a collection of 
independent data points. 

 persistence The persistence setting sets how 

MENU FUNCTION

中文
Language

F3

English
语言

F3
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long the old waveforms remain in 
the display, useful for observing 
the waveform variations. 

Panel operations 1. Press the MENU key and use the Up/Down 
keys to select the DISP SET menu. 

2. Press F1 (Type) or F2 (Persist) repeatedly to 
select vector drawing, dot drawing, and 
persistence time. 

 

Vector/dot 
drawing example 

Vector 

 

Dot 

 

Persistence 
example 

Persistence off 

 

Persistence infinite 

 

Viewing the System Status 
 

Overview The system status menu shows the GDS-122 
system settings. 

Panel operations 1. Press the MENU key and 
select the SYS STAT menu 
using the Up/Down keys. 

 

 2. Select the status menu from F1 (Horizontal) to 
F4 (Misc) and press it. The status information 

MENU DISP SET
Vectors

Type

Dots

F1

OFF
Persist

Infinite
1/2/5 sec

F2

MENU SYS STAT
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appears in the display. 

 

 

 3. To close the system status 
screen, select different menus 
using the MENU key 
followed by Up/Down keys. 

 

Horizontal status (F1) 

 

 

For details of each item, see the 
following pages. 

Time base: page 24 

Main/window scale: page 45 

Main/window position: page 45 

Display format: page 46 (XY) 

Acquire mode: page 33 

Vertical status (F2) 

 

 

For details of each item, see the 
following pages. 

CH1/CH2 scale: page 21 

CH1/CH2 position: page 21 

CH1/CH2 coupling: page 21 

CH1/CH2 probe: page 21 

Math mode: page 38 

CH1/CH2 invert: page 21 

Trigger status (F3): Edge trigger  

For details of each item, see the 
following pages. 

Trigger type: page 28 

Trigger source: page 28 

Trigger slope: page 28 

Horizontal Vertical Trigger Misc

F1 F2 F3 F4

MENU

HORIZONTAL SYSTEM STATUS

TIME BASE MAIN TIME BASE

MAIN SCALE 1.0ms

WINDOW SCALE 10.us

MAIN POSITION 300.0us

WINDOW POSITION 559.60us

DISPLAY FORMAT YT

ACQUIRE MODE SAMPLE

VERTICAL SYSTEM STATUS

SCALE CH1 2.00v

SCALE CH2 50.0mv

POSITION CH1 0.00 divs(0.0mv)

POSITION CH2 0.00 divs(0.0mv)

COUPLING CH1 DC

COUPLING CH2 DC

PROBE CH1 1X

PROBE CH2 1X

MATH CH1-CH2

INVERTED CH1 OFF

INVERTED CH2 OFF
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Trigger mode: page 28 

Trigger coupling: page 28 

Trigger status (F3): Video trigger 

 

 

For details of each item, see the 
following pages. 

Trigger type: page 31 

Trigger source: page 31 

Trigger polarity: page 31 

Trigger sync: page 31 

Misc status (F4) 

 

 

The Misc status shows the 
manufacturer name and the 
serial number. 

TRIGGER SYSTEM STATUS

TYPE EDGE

SOURCE CH1

SLOPE RISING

TRIGMODE SINGLE TRIGGER

COUPLING DC

TRIGGER SYSTEM STATUS

TYPE VIDEO

SOURCE CH1

POLARITY NORMAL

SYNC LINE

MISC

GW INSTEK

Series Number

W102206150095
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Measurements 
 

Overview The advanced measurement functions allow you 
to automatically measure various parameters in a 
waveform. 

Measurement 
items 

 Waveform math 

 Automatic measurements 

 Time cursor measurement 

 Voltage cursor measurement 

Page 38 

page 40 

page 41 

page 42 

Running Waveform Maths 
 

Overview The waveform math function runs mathematical 
operations between CH1 and CH2 waveform, and 
then shows the result in the display. 

Math type  CH1 – CH2 (subtract CH2 from CH1) 

 CH2 – CH1 (subtract CH1 from CH2) 

 CH1 + CH2 (add CH1 and CH2) 

 CH1 * CH2 (multiply CH1 and CH2) 

 CH1 / CH2 (divide CH1 by CH2) 

Panel operations 1. Make sure that both CH1 and CH2 waveforms 
are shown in the display. 

 2. Press the MENU key and 
select the WAVE MATH menu 
using the Up/Down keys. 

 

 3. Select the math operation from F1 (CH1 – 
CH2) to F5 (CH1 / CH2) and press it. 

 

 

 4. The math result appears in the display 
(example: adding two square waveforms) 

MENU WAVE MATH

CH1-CH2 CH2-CH1 CH1+CH2 CH1*CH2 CH1/CH2

F1 F2 F3 F4 F5
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 5. To cancel the math result, press the function 
key (F1 to F5) again. 

Changing the 
math result 

position 

1. Press the OSC OPTION key. 
Make sure the following menu 
appears on the display. 

 

 LEFT/RIGHT – Time 
UP/DOWN – CHM Zero  

 2. Use the arrow keys to move the 
math result position. 

 

Changing the 
math result scale 

1. Press the OSC OPTION key 
repeatedly until the following 
menu appears on the display. 

 

 LEFT/RIGHT – Time Base 
UP/DOWN – CHM Vol  

 2. Use the arrow keys to change 
the math result scale. 

 

Saving or 
recalling the 
math result 

The math result waveform can be saved into or 
recalled from one of the four GDS-122 internal 
memories. See page 54 for details. 

OSC
OPTION

OSC
OPTION
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Running Automatic Measurements 
 

Overview The automatic measurement function measures 
the input signal’s characteristics and lists them in 
the top left corner of the display. 

Source signal CH1, CH2 

Measurement set SET1, SET2 

Measurement 
items 

The following measurement items are available. 

 Frequency 

 Period 

 Mean voltage 

 Peak-to-peak voltage 

 Cycle voltage (true RMS) 

Panel operations 1. Make sure that the waveform appears. 

 2. Press the MENU key and 
select the MEAS SET1 or 
SET2 menu using the 
Up/Down keys. SET1 and 
SET2 correspond to the 
results in the upper left 
corner of the display. 

 

 

 

 3. Select the measurement type from F1 (Freq) to 

MENU

MEAS SET1

MEAS SET2

MEAS SET1 MEAS SET2

MEAS SET2

MEAS SET1

Measurement items
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F5 (Cyc). Press it repeatedly to select CH1 or 2. 

 

 

 4. The measurement result appears in the top left 
corner of the display. 

Running time Cursor Measurements 
 

Overview The time cursor function measures and updates 
the following three types of time difference. 

 Between cursor 1 and cursor 2 

 Between cursor 1 and center (zero) point 

 Between cursor 2 and center (zero) point 

Time cursor 
panel operations 

1. Make sure that the waveform appears. 

2. Press the MENU key and 
select the CURS MEAS menu 
using the Up/Down keys. 

 

 3. Press F1 (Type) repeatedly to 
select the Time cursor. The 
cursors appear as vertical 
purple lines located at the 
center of the display. 

 

 4. Press the OSC OPTION key 
repeatedly until the following 
menu appears. 

 

 LEFT/RIGHT – Time 

UP/DOWN – Cursor 
1(or Cursor2) 

 

 5. Use the arrow keys to move the cursor or 
horizontal position. 

Period Mean Pk-Pk Cyc RMS

F1 F2 F3 F4 F5

Freq

f T V Vp Vk
Top left 

corner

MENU CURS MEAS

Time
Type

F1

OSC
OPTION
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Running Voltage Cursor Measurements 
 

Overview The voltage cursor function measures and updates 
the following five types of voltage difference. 

 Between cursor 1 and cursor 2 

 Between cursor 1 and CH1 center point 

 Between cursor 2 and CH1 center point 

 Between cursor 1 and CH2 center point 

 Between cursor 2 and CH2 center point 

Source signal CH1 input, CH2 input 

Move the 
cursor left

Move the
cursor right

Move the 
horizontal 
position left

Move the 
horizontal 

position right

T1
Cursor

T2 - T0 time

T1 - T0 time

T1 - T2 time 
& frequency

Cursor 2 
menu

T0
(center)

T2
Cursor
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Voltage cursor 
panel operations 

1. Make sure the waveform appears. 

2. Press the MENU key and 
select the CURS MEAS menu 
using the Up/Down keys. 

 

 3. Press F1 (Type) repeatedly to 
select the Voltage cursor. The 
cursors appear as horizontal 
purple lines located at the 
center of the display. 

 

 4. Press F2 (Source) repeatedly 
to select the source channel. 

 

 5. Press the OSC OPTION key 
repeatedly until the following 
menu appears. 

 

 LEFT/RIGHT – Time 

UP/DOWN – Cursor V1 

(or Cursor V2) 

 

 6. Use the arrow keys to move the cursor or 
horizontal position. 

 

 

MENU CURS MEAS

Voltage
Type

F1

CH1
Source

F2

OSC
OPTION

OSC
OPTION

Move the 
cursor up

Move the 
cursor down

Move the 
horizontal 
position left

Move the 
horizontal 

position right
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Display overview 

(CH1, cursor 2) 

 

V2 - center

V1 - center

|V1 - V2|

Cursor 2 
menu

V1
Cursor

V2
Cursor
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Advanced Viewings 
 

Overview The advanced viewing functions allow you to 
clearly observe specific type of waveforms and/or 
particular characteristics in a waveform. 

Viewing items  Waveform zoom 

 X-Y format 

 Signal peaks 

 Noisy signals 

 Variations in a signal 

Page 45 

Page 46 

Page 47 

Page 47 

Page 48 

Zooming Waveforms Horizontally 
 

                                                                                                                                                                                                                                                                By using the zoom function, you can magnify the 
waveform in the horizontal direction. 

Panel operations 1. Make sure that the waveform appears in the 
display. 

 2. Press the MENU key and 
select the TIME MODE menu 
using the Up/Down keys. 

 

 3. Press F2 (Set Window). A set 
of cursors appears in the 
center of the display. 

 

 

 

MENU TIME MODE

Set
Window

F2

Zoom window
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 4. Press the OSC OPTION key 
repeatedly until the Time 
Base menu appears. 

 

 Cursor 1 menu 
 

 5. Use the arrow keys to change the zoom width. 

 

 

 6. Press F3 (Zone Window) to 
zoom into the window. 

 

Example 

 

Viewing Waveforms in X-Y Format 
 

Overview The X-Y format plots the CH1 input as X-axis and 
CH2 input as Y-axis. This display mode is 
convenient for viewing the phase relationship 
between CH1 and CH2. 

Panel operations 1. Make sure that both CH1 and CH2 waveforms 
appear in the display. 

OSC
OPTION

OSC
OPTION

Zoom out
vertical scale

Zoom in 
vertical scale

Wide rangeNarrow range

Zone
Window

F3
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 2. Press the MENU key and 
select the DISP SET menu 
using the Up/Down keys. 

 

 3. Press F3 (Format) and select 
XY. The display mode 
switches into the X-Y format. 

 

Changing the 
scale and 
position 

Press the OSC OPTION key 
repeatedly to access the menu listed 
below. In the X-Y mode, all scales and 
positions are controlled by the 
Up/Down keys.  

  CH1 Zero: horizontal position 

 CH2 Zero: vertical position 

 CH1 Vol: horizontal scale 

 CH2 Vol: vertical scale 

Functions not 
applicable in the 

X-Y format 

The following functions do not work in the X-Y 
format. 

 Cursor measurement (page 41, page 42) 

 Automatic measurement (page 40) 

 Window zoom (page 45) 

 Trigger settings configuration (page 24) 

Viewing Signal Peaks 
 

Overview Using the peak detect acquisition mode, the 
maximum and minimum data in the sampling 
interval are displayed, capturing the rapid 
changes and sudden peaks that might 
spontaneously occur in a waveform. 

Note Since the peak detect mode picks up the most 
extreme data, the waveform becomes noisier than 
the normal acquisition mode (sampling mode). 

Panel operations 1. Press the MENU key and use the Up/Down 
keys to select ACQU MODE menu. 

MENU DISP SET

XY
Format

F3

OSC
OPTION
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2. Press F2 (Peak Detect) to activate the peak 
detect mode. 

 

For other acquisition settings details, see page 28. 

Example 

Peak detect off 

 

Peak detect on 

 

Viewing Noisy Signals 
 

Overview Using the Average acquisition mode, you can 
smooth out the displayed waveform by averaging 
multiple data samples. The number of averaging is 
selectable from 4, 16, 64, and 128. 

Note  In order for the average mode to work in the 
best way, the waveform must be repetitive. 

 As the number of averaging increases, the 
slower the waveform update becomes. 

Panel operations 1. Press the MENU key and use the Up/Down 
keys to select ACQU MODE menu. 

2. Press F3 (Average) to activate the average 
mode. 

3. Press F4 (Averages) repeatedly to select the 
number of averaging. 

MENU ACQU MODE
Peak

Detect

F2
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For other acquisition settings details, see page 28. 

Example 

Average off 

 

Average 16 

 

Viewing Variations in a Signal 
 

Overview Using the persistence display function, you can 
define sets how long the old waveforms remain in 
the display, allowing observation of waveform 
variations. You can select the persistence time 
from 1, 2, and 5 sec. When choosing the Infinite 
mode, the GDS-122 keeps all past traces of the 
displayed waveform. 

Panel operations 1. Press the MENU key and use the Up/Down 
keys to select DISP SET menu. 

2. Press F2 (Persist) repeatedly to select the 
persistence time. 

 

MENU ACQU MODE Average
16

Averages

4
128
64

F3 F4

MENU DISP SET
OFF

Persist

Infinite
1/2/5 sec

F2
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For other display settings details, see page 34. 

Example 

Persistence off 

 

Persistence infinite 
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Calibration 
 

Overview Two types of calibrations are available: self-
calibration and probe calibration. The self- 
calibration automatically adjusts GDS-122 internal 
parameters. The probe calibration adjusts the 
probe capacitance. You should run both whenever 
using the GDS-122 in a new environment. 

Running the Self-calibration 
 

Overview The self-calibration function automatically 
configures internal parameters to maintain the 
sensitivity and accuracy. Run the self-calibration 
in the following cases. 

 When the temperature fluctuates more than 5 
degrees Celsius during operations 

 When operating the GDS-122 in a new 
benchtop or field environment 

Procedures 1. Press the MENU key and 
select the FUNCTION menu 
using the Up/Down keys. 

 

 2. Press F2 (Do Self Cal). A 
message appears on the 
display, asking you to 
remove all cables and probes 
from the GDS-122. 

 

 

 3. After removing all cables, 
press F2 (Do Self Cal) again. 
The self-calibration 
automatically starts and a 
message appears, showing 
that the calibration is 
ongoing. 

 

MENU FUNCTION

Do
Self Cal

F2

Self Calibration
Remove all probes & 
cables from (CH1 CH2)
Press <Do Self Cal> for 
Calibration
Press any key to quit

Do
Self Cal

F2
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 4. When the message disappears in 5 minutes, the 
calibration is completed. 

To interrupt 
calibration 

Press any key during calibration. 

Running the Probe Calibration 
 

Overview The attached probe contains a calibration point at 
the end to adjust the waveform. 

Procedures 1. Select a rectangular waveform as 
the signal input. Use the Autoset 
function and put the waveform 
in the middle of the display. 

 

 

 

 2. Adjust the probe calibration point to make sure 
that the waveform edge remains flat. 

 

 Over- Optimum Under-

Self calibration
....

AUTOSET
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compensation compensation 
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Saving/Recalling 
 

Overview The GDS-122 can save or recall four sets of 
waveforms using its internal memory. When you 
need to reset the system, recall the default (factory 
installed) settings. 

Save/recall items  Recalling default settings 

 Saving waveforms 

 Recalling waveforms 

Page 54 

Page 55 

Page 56 

Recalling the Default Settings 
 

Recalling the 
default settings 

You can recall the default factory settings by 
pressing the MENU key, then selecting 
FUNCTION → F1 (Recall Factory). 

 

Trigger Type: Edge 

Source: CH1 

Coupling: AC 

Slope: Rising 

Mode: Auto 

CH1 & CH2 Coupling: AC 

Probe scaling: 1 X 

Channel: ON 

Invert: OFF 

Measurement 1 Item: CH1 frequency  

Measurement 2 Item: CH2 frequency  

Cursor Cursor: OFF Channel: CH1 

Acquisition Mode: Sample Average number: 16 

Time mode Mode: Main timebase  

Display Type: Vector 

Format: YT 

Persistence: OFF 

Carry: Bitmap 

Wave Save Source: CH1 

Display: OFF 

Waveform: A 

FUNCTION
Recall

Factory

F1

MENU
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Saving Waveforms 
 

Overview Up to four waveforms can be stored in and 
recalled from the GDS-122 internal memory. The 
stored waveform can be used for reference, 
comparison xxxxxxxxx. 

Memory Four memories: waveform A, B, C, and D. 

Source CH1, CH2, Math waveform 

Panel operations 1. Make sure the waveform you want to save 
(CH1, CH2, or Math result) appears in the 
display. 
For Math operations details, see page 38. 

 2. Press the MENU key and 
select the WAVE SAVE menu 
using the Up/Down keys. 

 

 3. Press F1 (Source) repeatedly 
and select the waveform 
source. 

 

 4. Press F2 (WAVE) repeatedly 
and select the memory 
location from A to D. 

 

 5. Press F3 (Save) to confirm 
saving the waveform into the 
specified memory location. 
Make sure that the message 
“WAVE SAVE SUCCEEDED” 
appears in the display. 

 

  

WAVE SAVEMENU

CH1
Source

F1

A
Wave

F2

Save

F3

WAVE SAVE SUCCEEDED
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Recalling Waveforms 
 

Overview Up to four waveforms can be stored in and 
recalled from the GDS-122 internal memory. The 
stored waveform can be used for reference, 
comparison xxxxxxxxx. 

Memory Four memories: waveform A, B, C, and D. 

Source CH1, CH2, Math waveform 

Panel operations 1. Press the MENU key and 
select the WAVE SAVE menu 
using the Up/Down keys. 

 

 2. Press F2 (Wave) repeatedly 
and select the waveform you 
want to recall. 

 

 3. Press F4 and turn ON the 
waveform. The waveform 
appears in the display. 

 

 

 

Note The recalled waveform maintains its original 
horizontal scale and vertical scale, which are 
shown in the top left corner of the display. 
Changing the current scale does not affect the 
recalled waveform’s shape. 

WAVE SAVEMENU

A
Wave

F2

ON
CH A

F4
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Menu Tree / Operation Shortcuts 
 

Accessing 
menus 

The following menu trees are 
accessible by pressing the MENU 
key followed by Up/Down keys, 
except for the OSC OPTION key 
(page 61). 

 

Trigger 
 

 

Select run or stop mode RUN/STOP key 

Select edge or video trigger TRIG MODE→F1(TYPE) 

Select trigger slope TRIG MODE→F1(edge)→F2(Slope) 

Select trigger source TRIG MODE→F1→F3(Source) 

Select trigger mode TRIG MODE→F1(edge)→F4(Mode) 

Select trigger coupling TRIG MODE→F1(edge)→F5(Coupling) 

Select video polarity TRIG MODE→F1(video)→F2(Polarity) 

Select video line sync TRIG MODE→F1(video)→F4(Sync) 

CH1/CH2 Setup 
 

 

MENU

Edge
TYPE

Falling
Slope

CH1
Source

Single
Mode

DC
Coupling

TRIG MODE

Video
TYPE

Normal
Polarity

CH1
Source

Line
Sync

Rising CH2
Auto

Normal

AC
LF Rjc
HF Rjc

Inverted FieldCH2

RUN/STOP

F1 F2 F3 F4 F5

F1 F2 F3 F4

AC
Coupling

ON
Channel

1 X
Probe

OFF
Inverted

CH2 SETUP

OFF

1000 X
100 X
10 X ONDC

CH1 SETUP

F1 F2 F3 F4
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Select AC or DC coupling CH1/2 SETUP→F1(Coupling) 

Turn CH1 on or off CH1/2 SETUP→F2(Channel) 

Select probe scaling CH1/2 SETUP→F3(Probe) 

Turn inversion on or off CH1/2 SETUP→F4(Inverted) 

Measurement Setup 1/2 
 

 

Measure CH1/CH2 frequency MEAS SET1/2→F1(Freq) 

Measure CH1/CH2 period MEAS SET1/2→F2(Period) 

Measure CH1/CH2 mean value MEAS SET1/2→F3(Mean) 

Measure CH1/CH2 peak to peak time MEAS SET1/2→F4(Pk-Pk) 

Measure CH1/CH2 cycle MEAS SET1/2→F5(Cyc RMS) 

Wave Math 
 

 

Subtract CH2 from CH1 WAVE MATH→F1(CH1-CH2) 

Subtract CH1 from CH2 WAVE MATH→F2(CH2-CH1) 

Add CH2 to CH1 WAVE MATH→F3(CH1+CH2) 

Multiply CH2 with CH1 WAVE MATH→F4(CH1*CH2) 

Divide CH1 by CH2 WAVE MATH→F5(CH1/CH2) 

Cursor Measurement 
 

 

Activate cursor measurement CURS MEAS→F1(Type) 

Select source channel CURS MEAS→F2(Source) 

Freq Period Mean Pk-Pk
MEAS SET2

CH2
CH1

MEAS SET1

Cyc RMS

CH2
CH1

CH2
CH1

CH2
CH1

CH2
CH1

F1 F2 F3 F4 F5

CH1-CH2 CH2-CH1 CH1+CH2 CH1*CH2
WAVE MATH

CH1/CH2

F1 F2 F3 F4 F5

OFF
Type

CH1
Source

CURS MEAS

Time
Voltage CH2

F1 F2
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Acquisition Mode 
 

 

Select sampling mode ACQU MODE→F1(Sample) 

Select peak detect mode ACQU MODE→F2(Peak Detect) 

Select average mode ACQU MODE→F3(Average) 

Select average number ACQU MODE→F3→F4(Averages) 

Time Mode 
 

 

Select main timebase TIME MODE→F1(Main TimeBase) 

Set window zoom width TIME MODE→F2(Set Window) 

Zoom window TIME MODE→F3(Zone Window) 

Function 
 

Recall factory settings FUNCTION→F1(Recall Factory) 

Run self calibration FUNCTION→F2(Do Self Cal) 

Select language FUNCTION→F3(Language) 

Display 
 

 

Select line display DISP SET→F1(Type) 

Select persistency DISP SET→F2(Persist) 

Sample
Peak

Detect
ACQU MODE Average

16
Averages

4
128
64

F1 F2 F3 F4

Main
TimeBase

Set
Window

TIME MODE
Zone

Window

F1 F2 F3

Vectors
Type

OFF
Persist

DISP SET
YT

Format
Bitmap
Carry

Dots

Infinite
5 sec
2 sec
1 sec XY Vectors

F1 F2 F3 F4
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Select display format DISP SET→F3(Format) 

Select display save format DISP SET→F4(Carry) 

Wave Save 
 

 

Select source channel WAVE SAVE→F1(Source) 

Select waveform ID WAVE SAVE→F2(Wave) 

Save waveform WAVE SAVE→F3(Save) 

Turn waveform display on or off WAVE SAVE→F4(CH A/B/C/D) 

System Status 
 

 

Show horizontal settings SYS STAT→F1(Horizontal) 

Show vertical settings SYS STAT→F2(Vertical) 

Show trigger settings SYS STAT→F3(Trigger) 

Show serial number SYS STAT→F4(Misc) 

CH1
Source

A
Wave

WAVE SAVE Save
OFF
CH

Math OFF
CH2

D
C
B ON

F1 F2 F3 F4

Horizontal VerticalSYS STAT Trigger Misc

F1 F2 F3 F4
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OSC OPTION Key 
 

 

Press the OSC OPTION key repeatedly. The 
menu message appears in the lower half of 
the display and the functionalities of four 
keys, UP, DOWN, RIGHT, LEFT, change 
accordingly. 

 

 

 

LEFT/RIGHT: CH1/CH2 horizontal position 

UP/DOWN: CH1 vertical position 

LEFT/RIGHT: CH1/CH2 horizontal position 

UP/DOWN: CH2 vertical position 

LEFT/RIGHT: CH1/CH2 horizontal position 

UP/DOWN: Trigger vertical position 

LEFT/RIGHT: horizontal scale 

UP/DOWN: CH1 vertical scale 

LEFT/RIGHT: horizontal scale 

UP/DOWN: CH2 vertical scale 

(Math mode) 

LEFT/RIGHT – Time 

UP/DOWN – CHM Zero 

(Math mode) 

LEFT/RIGHT: Math horizontal position 

UP/DOWN: Math vertical position 

(Cursor mode) 

LEFT/RIGHT – Time 

UP/DOWN – Cursor 1/2 

(Cursor mode) 

LEFT/RIGHT: CH1/CH2 horizontal position 

UP/DOWN: Cursor 1/2 vertical position 

OSC
OPTION

UP

DOWN

RIGHTLEFT

LEFT/RIGHT - Time
UP/DOWN - CH1 Zero

LEFT/RIGHT - Time
UP/DOWN - CH2 Zero

LEFT/RIGHT - Time
UP/DOWN - Trig

LEFT/RIGHT - Time Base
UP/DOWN - CH1 Vol

LEFT/RIGHT - Time Base
UP/DOWN - CH2 Vol
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Using the Software 
 

Overview The GDS-122 PC software, included in the CD-
ROM, allows you to view the waveforms in your 
familiar PC environment – large display and 
mouse operation. Multiple cursors provide flexible 
waveform measurements. 

Software 
functionalities 

The PC software can run the following 
measurement and actions. 

 Viewing real-time updated waveforms 

 Running up to 6 cursor measurements 

 Measuring period/frequency/pk-pk voltage 

 Printing out waveform images 

 Saving and recalling waveform shape and data 

Software 
operations 

The following is the list of software operations 
described in this chapter. 

  Installing the software 

 Modifying, reinstalling, or 
uninstalling the software 

 Connecting the GDS-122 

 Configuring the screen 

 Viewing waveforms 

 Measuring waveforms 

 Saving waveforms 

 Recalling waveforms 

 Printing out waveforms 

 Accessing the Help 

Page 63 

Page 65 
 

Page 66 

Page 70 

Page 71 

Page 78 

Page 78 

Page 80 

Page 83 

Page 85 

Note The PC software is intended for oscilloscope 
operations only; it does not include multimeter 
operations. 
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Installing the Software 
 

PC requirements  Windows 2000 or XP 

 20MB hard drive space 

 USB host port x 1 

Installation steps 1. Activate the Setup.exe file in the 
CD-ROM. 

 

 2. The language selection window appears. Select 
the software language and click OK (you can 
later change the language manually). 

 English 

 

Simplified Chinese 

 

 

 

 3. The software starts preparing the installation. 
When the welcome window is displayed, click 
Next and start installing the software to your 
PC. 

 

 

 

 4. The customer information window will appear. 
Enter the user name and organization name. 
Select which user will hold the right to access 
the software and click Next. 
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 5. Change the installation directory if necessary 
and click Next. 

 

 

 

 6. Click Install to start installing the software. 

 

 

 

 7. The software installation automatically starts 
and ends. Click Finish to complete installation. 

 

 

 

Installing the software is completed 

User Name

Organization

Administration
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Modifying/Reinstalling/Uninstalling the Software 
 

Overview After installing the software, you can do the 
followings using the same setup file. 

 Modifying the software components 

 Repairing the software 

 Uninstalling the software 

Steps 1. Activate the Setup.exe. Follow 
the same procedures as 
installing the software until the 
Program Maintenance window 
appears. 

 

 

 

 2. Select the action – Modify the software 
components, Repair the software, or Remove 
(uninstall) the software – and click Next. 
Proceed according to the instructions. 

Shortcut for 
uninstall 

Alternatively, you can select the Uninstall 
DC_Wave from the program startup menu to 
uninstall the software. 
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Activating the Software and Connecting the GDS-122 
 

Overview Activate the software and connect the GDS-122 to 
it properly by going through these steps, 
described in the paragraphs that follow. 

1. Activating the software and configuring the 
communication port 

2. Activating the GDS-122 and configuring the 
data format 

3. Connecting them together and if necessary, 
installing the USB driver 

4. Acquiring waveform data to confirm that the 
communication is being secured 

Activating the 
software 

1. Open the software by 
selecting DS_Wave.exe 
from the startup menu. 

 

 2. Select Communications – 
Ports Settings from the 
menu or click the Ports-
settings icon on the 
Toolbar. 

 

 

 Make sure that USB connection is being 
selected. The baud rate, stop bit, data bit, and 
parity settings are fixed. 
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Activating the 
GDS-122 

1. Power up the GDS-122 and activate the 
oscilloscope screen. 

 2. Connect an input signal to CH1 and make sure 
that the waveform is shown appropriately on 
the GDS-122 display. 

 3. Open the DISP SET menu and press F4 (Carry) 
to select the format of the waveform data sent 
from the GDS-122 to the software. 

 

 

 Vectors Vectored data of the waveform. 
Always select the vector format when 
viewing the waveform in the software. 

 Bitmap Bitmap image of the display. Select 
the Bitmap format only when taking 
the bitmap snapshot of the GDS-122 
hardware screen. 

Connecting the 
cable 

1. Connect the GDS-122 to the PC (software) via 
the USB cable. 

 2. Make sure that the USB driver is installed in 
your PC by accessing the Device Manager 
(Control Panel -> System -> Hardware tab). The 
GDS-122 should be recognized as a USB hub. 

 

 

 3. If the driver has not been 
recognized, install it 
manually by selecting 
USBDRV Install from the 
startup menu.  

 The driver file is located in the USBDRV folder 

MENU DISP SET
Bitmap
Carry

Vectors

F4
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in the software directory. 

Acquiring data In the software, select 
Communications – Get Data 
from the menu. 
Alternatively, you may click 
the Get data icon, or press 
the Ctrl + A key. 

 

 

 Acquiring the GDS-122 display snapshot 

When the “Bitmap” format is selected in the GDS-
122 display carry setting, the software acquires the 
display snapshot (*.bmp) at the moment. Save the 
file in the local folder and use a graphic software 
to open and edit it. 

 Acquiring the GDS-122 waveform 

When the “Vectors” format is selected in the GDS-
122 display carry setting, the software acquires the 
waveform data (*.bin) at the moment. 

 1. The waveform data will be stored in the PC 
memory to allow to be recalled later (page82). 
Edit the location and click Start. 

 

 2. The waveform appears in the software screen. 
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Connecting the GDS-122 to the software is completed 
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Configuring the Screen 
 

Overview This section introduces how to configure the 
following parameters in the software screen 
(waveform viewing mode) to optimize the user 
interface. 

  Background color 

 Grid color 

 Grid on/off 

 Drawing format 

 Language 

 Closing the software 

Screen overview  

 

Changing the 
background 

color 

To change the background color, 
select View > Background Color 
from the menu and select the 
new color from the color palette 
that appears. Alternatively, you 
can also double click inside the 
screen to call the color palette. 

 

 Black background 

 

White background 

 

Tool bar
& Icons

Vertical scale
Waveform

list

Cursor type

Measurement 
result

CH2

CH1

File
location Model name

Horizontal 
scale
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Turning the grid 
on or off 

To turn on or off the grid, select 
View > Grid lines from the menu 
or click the Gridlines icon. 

 

 

 Grid on 

 

Grid off 

 

Changing the 
grid color 

Make sure the grid is already 
turned on. Select View > Grid 
Color from the menu and select 
the new color from the color 
palette that appears.  

 Blue grid 

 

White grid 

 

Changing the 
waveform 

drawing format 

You can select how the waveform is being drawn 
from two formats, line and dots. Select Format > 
Data Line (Point) from the menu or click the icons. 

 Line 

  

 

Point 
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Changing the 
language 

You can select the language from English (default) 
or Simplified Chinese. Select Language > English 
(Chinese) from the menu. The Language menu 
itself always stays as English. 

 English 

 

 

Chinese 

 

 

Closing the 
software 

You can close the software in one of the following 
ways. The screen configurations will be retained 
the next time you open the software. 

  Pressing the Alt + F4 keys  

  Selecting File > Exit from the 
menu 

 

  Clicking the Close icon at the 
top right corner of the software  
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Viewing the Waveforms 
 

Overview This section introduces how to modify the 
waveform settings for better viewings. 

  Selecting the displayed waveforms 

 Refreshing the waveforms 

 Selecting the active waveform 

 Changing the waveform positions 

 Changing the waveform scales 

 Viewing the automatic measurement results 

Screen overview  

 

Selecting the 
displayed 

waveforms 

In the left bottom corner of the screen, put a 
checkmark in the waveform that needs to appear. 
Maximum six waveforms are available: CH1, CH2, 
A, B, C, D. Waveforms A to D have to be stored in 
the GDS-122 hardware beforehand (see page 55 for 
details). 

 (CH1, CH2 selected) 

Vertical scale

Waveform
list

Measurement 
result

CH2

CH1

Horizontal 
scale

Active waveform
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Refreshing the 
waveforms 

In the software, select 
Communications – Get Data 
from the menu. Alternatively, 
you may click the Get data icon, 
or press the shortcut keys, Ctrl + 
A. 

 

 

Selecting the 
active waveform 

Waveform scale settings and automatic 
measurements are done on the active waveform. 

 1. Click on the waveform name in the bottom left 
corner of the screen. 

(CH1 selected as the active waveform) 

 

 

 2. The following locations changes into the 
selected channel (example: CH1). 

  Colored channel label (at the 
left side of the screen)  

  Cursor, Time base, Voltage 
settings (at the right side of 
the screen) 

 

 

 

  Automatic measurement 
results (at the bottom right 
corner of the display) 

 

Changing the 
waveform 
positions 

Changing the horizontal position 

1. Move the mouse over the waveform until the 
mouse icon changes into a left-right arrow. 
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 2. Hold the mouse and drag the waveform 
sideways. 

 

 

 Changing the vertical position 

Click the channel label at the left side of the 
waveform and drag the waveform up or down. 

 

 

Changing the 
waveform scales 

Before changing the scales, make sure that the 
correct waveform is selected (highlighted) in the 
lower left corner of the screen (example: CH1). 

 

 

 Changing the horizontal scale 

 Select the horizontal scale using 
the list at the right side of the 
screen. You can select the scale 
either by searching in the Scale 
column or by clicking the 
Position arrows.  
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 Changing the vertical scale 

 Select the vertical scale using 
the list at the right side of the 
screen. You can select the scale 
either by searching in the Scale 
column or by clicking the 
Position arrows.  

 

 

 

 

 

 

 

Viewing the 
automatic 
measurement 
results 

Before viewing the measurement results, make 
sure that the correct waveform is selected 
(highlighted) in the lower left corner of the screen 
(example: CH1). 

 

 

 The measurement result 
is updated in the lower 
right corner of the 
screen. Three parameters 
are listed.  

  Period: measures the waveform period in ms. 

 Freq: measures the waveform frequency in 
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kHz. 

 PK-PK: measures the peak to peak voltage in V. 
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Using the Cursor Measurements 
 

Overview This section introduces how to use cursor 
measurements in the software screen. 

  Activating the cursors 

 Viewing the cursor measurement results 

 Moving the cursors 

Screen overview  

 

Activating the 
cursors 

Before activating the cursors, make sure that the 
correct waveform is selected (highlighted) in the 
lower left corner of the screen (example: CH1). 

 

Select the cursors from the list in the right side of 
the screen. 

  None: the cursor is turned off. 
 

  Horizontal: the horizontal 
cursors appear.  

  Vertical: the vertical cursors 
 

Measurement 
result

Horizontal 
cursor

Vertical cursor

Cursor type
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appear. 

  All: both the horizontal and 
vertical cursors appear.  

Viewing the 
cursor 
measurement 

results 

The cursor measurement 
results are updated in the 
right side of the screen. 

 dy: the voltage difference 
between y1 and y2 cursors 

 y1, y2: voltage cursors 1 
and 2 

 dx: the time difference 
between x1 and x2 cursors 

 x1, x2: time cursors 1 and 2  

 

 

Moving the 
cursors 

Move the mouse over the cursor until the mouse 
icon changes into a left-right arrow. Hold the 
mouse and drag the cursor sideways (horizontal 
cursor) or vertically (vertical cursor). 

 

 

The cursor measurement result changes 
accordingly. 

0.0V

y1

y2

dy

x1 x20.0s

dx
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Saving Waveforms 
 

Overview You can save the waveforms into the PC in two 
ways. For details of recalling them, see page 82. 

 Storing waveform data (*.bin file, for viewing 
in the software) 

 Storing data points (*.txt file, for data analysis 
such as in graphs and maps) 

For details of storing waveforms into the GDS-122 
hardware, see page 55. 

Storing 
waveform data 

When retrieving waveform data from the GDS-
122, the waveform data (*.bin format) is 
automatically stored. For details, see page 71. 

Storing data 
point 

1. Make sure that the waveform is being 
displayed in the screen. To recall waveforms 
that are stored in the PC, see page 82. 

 2. Select View > Data Table from the 
menu, or click the Data Table 
icon on the Toolbar. The Data 
Table dialogue appears.  

 

 

 

Close window

Save data

Save option



  USING THE OSCILLOSCOPE 

81 

 3. Select the data to be saved from 
the Save column. 

 sequence: the identification 
number for each data point 

 ch1/ch2: CH1 and CH2 waveform 
data 

 A/B/C/D: the waveforms stored 
in the GDS-122 hardware 
memory 

 

 Data points stored in an Excel sheet (example) 

 

 4. Click the Save As… button to 
save the data into a directory. 
The standard Save dialog 
appears. 

 

 5. To close the Data Point dialogue, do one of the 
following actions. 

 Press the Ctrl + Alt key 

  Click the Exit icon 

 

  Click the Close icon at the top 
right corner of the dialogue  

sequence ch1 / ch2 A / B / C / D
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Recalling Waveforms 
 

Overview You can recall the waveforms from the PC in two 
ways. For details of saving them, see page 80. 

 Recalling waveform data (*.bin file, for viewing 
in the software) 

 Recalling data points (*.txt file, for data 
analysis such as in graphs and maps) 

For details of recalling waveforms into the GDS-
122 hardware, see page 56. 

Recalling the 
waveform data 

1. Select File > Open from the 
menu or press the shortcut 
key, Ctrl + O.  

 2. The File Open dialogue opens. Select one of the 
SPB bin file (*.bin) and click OK. 

 3. The waveform(s) will be recalled in the screen. 

 

 

Recalling the 
data points 

1. For recalling the data points, you need to open 
a text editor or a spreadsheet program like 
Excel, in which you can organize the data and 
create graphs and maps for advanced analysis. 

 2. Open the saved *.txt file from the application. 
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Printing out Waveforms 
 

Overview You can print out the screen contents to a printer 
connected to the PC. When you are printing the 
waveform for the first time, follow all the steps in 
the following order. 

1. Setting up the printer 

2. Setting up the page format 

3. Printing out 

Setting up the 
printer 

1. Select File > Printer Setup 
from the menu. The standard 
printer setting dialogue 
opens. 

 

 2. Select the printer and its properties, paper size, 
and orientation. 

Setting up the 
page format 

1. Select File > Page Setup from 
the menu. The Page Setup 
dialog window opens. 

 

 

 

 2. Set the borderlines (print margins). The range 
is 0 to 10.0cm each. 

Borderline

View Setting
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 3. Select the View Setting. 

 Redraw graph according to sample data: 

The GDS-122 refreshes the waveform and 
adjust its scale before printing. The most recent 
data can be taken, but might take time for 
refreshing. 

 Graph zoom in and out 

The existing waveform is used with its scale 
adjusted. Since retrieving the data is not 
involved, fast printing is ensured. 

 4. Open the print preview by 
selecting File > Print Preview 
from the menu or clicking the 
Print Preview icon on the 
toolbar. Make sure that the 
waveforms are placed 
appropriately. 

 

 

Printing out Print out the waveform in one of the following 
ways. 

  Selecting File > Print in the 
Print Preview screen menu 

 

  Selecting File > Print from the 
software menu 

 

  Pressing the shortcut keys, Ctrl + P 

  Clicking the Printer icon on 
the Toolbar  
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Accessing the Help 
 

Overview The Help file describes how to install and use the 
software. The About screen shows the software 
version. 

Opening the 
Help 

Open the Help in separate file using one of the 
following methods. 

  Selecting Help > Help from the 
menu 

 

  Clicking the Help icon on the 
Toolbar  

  Pressing the shortcut key, F1  

  Selecting the Help documentation from the 
startup menu 

 

Software version To view the software version, 
select Help > About from the 
menu. The software version 
screen appears. 
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USING THE MULTIMETER 
This chapter describes the multimeter 
functionalities in the GDS-122. Functionalities 
includes three major items (Voltage, Current, 
Impedance) and three additional items (Diode, 
Continuity, Capacitance). The current 
measurement and capacitance measurement use 
extension modules to deal with large current and 
small capacitance, respectively. Delta 
measurement and automatic range switching 
features offer flexibility and convenience. 

 

Activating the Multimeter........................................... 87 

Measuring Voltage ..................................................... 88 

Measuring Current ..................................................... 90 

Measuring Impedance ................................................ 93 

Measuring Diode ....................................................... 95 

Measuring Continuity................................................. 96 

Measuring Capacitance .............................................. 97 
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Activating the Multimeter 
 

Panel operations 1. Press the power switch. The 
welcome screen with the corporate 
logo appears on the display. 

 

 2. To adjust display brightness, use 
the switch on the side: up (bright) 
or down (dark).  

 3. Press any key (example: MENU 
key) to activate the display. The 
battery icon at the top left corner of 
the display shows the battery level. 

(Example) 

 

 > 75% 

 

75% 

 

50% 

 

25% 

 

< 25% 

 

 If the oscilloscope screen appears, 
press the DMM/OSC key and 
change the mode to multimeter. 

 

 4. Press A (current), V (voltage), or R 
(impedance, diode, continuity, 
capacitance) switch to proceed. A 
warning message might appear to 
remind you of correct connections. 

 

 

 

 5. Press any key to cancel the warning message 
and resume the measurement. 

MENU

DMM/OSC

A

V

R

Plug the Multimeter 
test leads in the
right position!

(Press any key to make sure)
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Measuring Voltage 
 

DC voltage 
specifications 
(details: page 

102) 

Range 

Accuracy 

Max input 

400mV, 4V, 400V 

±(1% + 1 digit) 

400V 

AC voltage 
specifications 
(details: page 
102) 

Range 

Accuracy 

Max input 

Frequency 

4V, 40V, 400V 

±(1% + 3 digits) 

400V 

40Hz to 400Hz 

Panel operations 1. Press the V switch to select the 
Voltage measurement. If a warning 
message appears, press any key to 
resume measurement. 

 

 2. The voltage measurement screen appears. 

 

 3. Press the AUTOSET key 
repeatedly to select DC or AC 
voltage measurement. 

 

 4. Connect the test leads to the 
terminals: 
COM for the black lead 
V/Ω/C for the red lead  

 5. The measurement result will be constantly 
updated in the display. For more detailed 

V

V

Battery level

Measurement 
unit

Scaling factor

F1-F3 menu

Auto/Manual 
range

Run/Stop

Delta 
measurement 
result

Measurement 
result

Meter

-83.60mV

DCV/ACV

AUTOSET

400V
400V
MAXCOM V/Ω/C

(black) (red)
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settings, see the following instructions. 

Auto ranging To let the GDS-122 select the voltage 
range automatically, press F3 (Auto). 
The indicator at the top left corner of 
the display changes to AUTO. 

 

 

Manual ranging To select the voltage range manually, 
press F1 (Manual). The indicator at the 
top left corner of the display changes 
to MANUAL. 

 

 

Freezing the 
measurement 

To freeze the measurement, press the 
RUN/STOP key. The measurement 
result will be retained and the 
indicator at the top right corner of the 
display changes to STOP. To unfreeze, 
press the RUN/STOP key again. 

 

 

Measuring delta 
voltage 

To measure the delta value, press F2 
(II/Δ). The measurement result at the 
moment moves to the top right corner 
of the display, and the measurement 
result becomes the difference between 
the original result. 

 

 

F3

Auto

AUTO

F1

Manual

MANUAL

RUN/STOP

RUN

STOP

F2

II/Δ

2. Measurement 
    reset to zero

200.0V

1. Press F2 3. Delta value 
    displayed
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Measuring Current 
 

DC current 
specifications 
(details: page 

102) 

Range & 
Accuracy 

 

Max input 

40mA ±(1% + 1 digit) 
400mA ±(1.5% + 1 digit) 
20A ±(3% + 3 digits) 

400mA (direct input) 
20A (via the extension module) 

AC current 
specifications 
(details: page 
102) 

Range &  
Accuracy 

 

Max input 

40mA ±(1.5% + 3 digits) 
400mA ±(2% + 1 digit) 
20A ±(5% + 3 digits) 

400mA (direct input) 
20A (via the extension module) 

Panel operations 1. Press the A switch to select the 
current (Ampere) measurement. If 
a warning message appears, press 
any key to resume measurement. 

 

 

 2. Press the AUTOSET key 
repeatedly to select DC or 
AC current measurement. 

 

Measuring 0mA 
to 400mA 

1. Connect the test leads to the 
terminals: 
COM for the black lead 
mA/A for the red lead  

 If the range is set at 20A, 
press F4 (mA) and change it 

  

A

A

Battery level

Measurement 
unit

Scaling factor

F1-F5 menu

Auto/Manual 
range

Run/Stop

Delta 
measurement 
result

Measurement 
result

Meter

-83.60mA

DCA/ACA

AUTOSET

400mA
MAX

mA/A COM

(black)(red)

F2

mA

20A mA
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to mA range. 

 2. Select automatic range by 
pressing F3 (Auto) or manual 
by F1 (Manual). The indicator 
at the top left corner of the 
display changes accordingly. 

  

  

Measuring 
400mA to 20A 

 

1. Connect the Current 
Extension module to the 
COM & mA/A terminals. 
Then, connect the test leads 
to the extension module. 

 

 2. Press F5 (20A) and select the 
20A range. The MANUAL 
range indicator activates. 
(Auto range is not available) 

  

Freezing the 
measurement 

To freeze the measurement, press the 
RUN/STOP key. The measurement 
result will be retained and the 
indicator at the top right corner of the 
display changes to STOP. To unfreeze, 
press the RUN/STOP key again. 

 

 

Measuring delta 
current 

To measure the delta value, press F2 
(II/Δ). The measurement result at the 
moment moves to the top right corner 
of the display, and the measurement 
result becomes the difference between 
the original result. 

 

F1

Manual

F3

Auto

MANUAL AUTO

20 AMP

400mA
MAX

mA/A COM

(black)(red)

F5

20A

MANUAL

RUN/STOP

RUN

STOP

F2

II/Δ
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2. Measurement 
    reset to zero

20.0mA

1. Press F2 3. Delta value 
    displayed
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Measuring Impedance 
 

Impedance 
specifications 
(details: page 

102) 

Range & 
Resolution 

400Ω ±(1% + 3 digits) 

4k, 40k, 400k, 4MΩ ±(1% + 1 digit) 

40MΩ ±(1.5% + 3 digits) 

Panel operations 1. Press the R switch. If a warning 
message appears, press any key to 
resume measurement.  

 2. Press the AUTOSET key repeatedly 
to select the impedance 
measurement. 

 

 3. The impedance screen appears. 

 

 4. Connect the test leads to the 
terminals: 
COM for the black lead 
V/Ω/C for the red lead  

 5. The measurement result will be constantly 
updated in the display. For more detailed 
settings, see the following instructions. 

Auto ranging To let the GDS-122 select the voltage 
range automatically, press F3 (Auto). 
The indicator at the top left corner of 
the display changes to AUTO. 

 

 

R

Ω/  /  /C

AUTOSET

Battery level

Measurement 
unit

Scaling factor

F1-F3 menu

Auto/Manual 
range

Run/Stop

Delta 
measurement 
result

Measurement 
result

Meter

-100.0kΩ

Impedance

400V
400V
MAXCOM V/Ω/C

(black) (red)

F3

Auto

AUTO
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Manual ranging To select the voltage range manually, 
press F1 (Manual). The indicator at the 
top left corner of the display changes 
to MANUAL. 

 

 

Freezing the 
measurement 

To freeze the measurement, press the 
RUN/STOP key. The measurement 
result will be retained and the 
indicator at the top right corner of the 
display changes to STOP. To unfreeze, 
press the RUN/STOP key again. 

 

 

Measuring delta 
impedance 

To measure the delta value, press F2 
(II/Δ). The measurement result at the 
moment moves to the top right corner 
of the display, and the measurement 
result becomes the difference between 
the original result. 

 

 

F1

Manual

MANUAL

RUN/STOP

RUN

STOP

F2

II/Δ

2. Measurement 
    reset to zero

120.0kO

1. Press F2 3. Delta value 
    displayed
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Measuring Diode 
 

Range 0V to 1.5V 

Panel operations 1. Press the R switch. If a warning 
message appears, press any key to 
resume measurement.  

 2. Press the AUTOSET key repeatedly 
to select the diode measurement.  

 3. The diode measurement screen appears. 

 

 4. Connect the test leads to the 
terminals: 
COM for the black lead 
V/Ω/C for the red lead  

 5. The measurement result will be constantly 
updated in the display. 

Freezing the 
measurement 

To freeze the measurement, press the 
RUN/STOP key. The measurement 
result will be retained and the 
indicator at the top right corner of the 
display changes to STOP. To unfreeze, 
press the RUN/STOP key again. 

 

 

R

Ω/  /  /C

AUTOSET

Battery level

Measurement 
unit

Scaling factor

F1-F3 menu 
(not used)

Manual range

Run/Stop

Measurement 
result

Meter

Diode

400V
400V
MAXCOM V/Ω/C

(black) (red)

RUN/STOP

RUN

STOP
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Measuring Continuity 
 

Conditions < 50Ω (beeping) 

Panel operations 1. Press the R switch. If a warning 
message appears, press any key to 
resume measurement.  

 2. Press the AUTOSET key repeatedly 
to select the continuity 
measurement. 

 

 3. The continuity measurement screen appears. 

 

 4. Connect the test leads to the 
terminals: 
COM for the black lead 
V/Ω/C for the red lead  

 5. If the GDS-122 confirms continuity (the 
impedance is less than 50Ω), the beeper 
sounds. 

Freezing the 
measurement 

To freeze the measurement, press the 
RUN/STOP key. The measurement 
result will be retained and the 
indicator at the top right corner of the 
display changes to STOP. To unfreeze, 
press the RUN/STOP key again. 

 

 

R

Ω/  /  /C

AUTOSET

Battery level

Measurement 
unit

Scaling factor

F1-F3 menu 
(not used)

Manual range

Run/Stop

Measurement 
result

Meter

Continuity

400V
400V
MAXCOM V/Ω/C

(black) (red)

RUN/STOP

RUN

STOP
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Measuring Capacitance 
 

Continuity 
specifications 

Range 51.2nF to 100uF ±(3% + 3 digits) 

Panel operations 1. Press the R switch. If a warning 
message appears, press any key to 
resume measurement.  

 2. Press the AUTOSET key repeatedly 
to select the capacitance 
measurement. 

 

 3. The capacitance screen appears. 

 

Measuring 5nF 
and above 

Connect the test leads to the CX 
terminals. 

 

Measuring less 
then 5nF 

 

Connect the Capacitance 
Extension module to the COM 
& V/Ω/C terminals. Then, 
connect the test leads to the 
extension module. The 
measurement result will be 
constantly updated in the 
display. 

 

  

R

Ω/  /  /C

AUTOSET

Battery level

Measurement 
unit

Scaling factor

F1-F3 menu 
(F1, F3 not 

used)

Auto range

Run/Stop

Delta 
measurement 
result

Measurement 
result

Meter

Capacitance

CX

CATII
400V

CX <5nf

400V
400V
MAXCOM V/O/C
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Freezing the 
measurement 

To freeze the measurement, press the 
RUN/STOP key. The measurement 
result will be retained and the 
indicator at the top right corner of the 
display changes to STOP. To unfreeze, 
press the RUN/STOP key again. 

 

 

Measuring delta 
capacitance 

To measure the delta value, press F2 
(II/Δ). The measurement result at the 
moment moves to the top right corner 
of the display, and the measurement 
result becomes the difference between 
the original result. 

 

 

RUN/STOP

RUN

STOP

F2

II/Δ

2. Measurement 
    reset to zero

59.6nF

1. Press F2 3. Delta value 
    displayed
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FAQ 
 

Power Q  The GDS-122 does not power up. 

 The GDS-122 stopped working after a short 
period of time. 

 A The battery may need recharging. Connect the 
GDS-122 to the AC adaptor and recharge it for 
at least 15 minutes. Then try powering up. 

ERR mode in the 
multimeter 

Q In the multimeter mode, the measurement 
type at the top of the display says “ERR” 
which looks like an error message. 

 A The “ERR” sign appears when none of the 
measurement switch is pressed. Select one 
from the V, A, or R switch and press it. 

Amplitude 
mismatch in the 
oscilloscope 

Q The measured voltage is 10 times smaller than 
the real value. 

A The attenuation ratio on the probe is set at x10. 
If you switch it to x1, make sure that the input 
voltage does not surpass the maximum 400V. 

 Q The measured voltage is 10/100/1000 times 
larger than the real value. 

 A The probe ratio in the CH1 or CH2 setup 
menu is set at X10, X100, or X1000. See page 21 
for details. 

Unstable 
waveform in the 
oscilloscope 

Q The waveform appears in the display but is 
not stable. 

A Configuring the trigger might help you. See 
page 28 for details. 

 Make sure the trigger source channel 
matches the input signal. 
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 Make sure the correct trigger type, edge or 
video, is selected. 

 Try changing the HF and LF repression in 
the trigger coupling mode and filtering out 
high or low frequency noise. 

No waveform in 
the oscilloscope 

Q The waveform does not appear at all in the 
display. 

 A  The trigger level might be out of the 
waveform range. Press the AUTOSET key 
so that the GDS-122 automatically adjusts 
the trigger level. 

 If the trigger mode is Single, press the 
RUN/STOP key to trigger the waveform or 
switch the trigger mode to Normal. See 
page 28 for trigger details. 

Slow update in 
the multimeter 

Q It takes 30 to 40 seconds for the multimeter to 
update the capacitor measurement. 

 A It takes longer time to measure small 
capacitors. 30 to 40 seconds are normal for 
measuring 5nF or smaller capacitors. See page 
97 for capacitance measurement details. 

Slow update in 
the oscilloscope 

Q The display response to the waveform change 
is unusually slow. 

 A Slow response is normal in the following 
cases. 

 Average sampling mode is being selected 
(page 21) 

 Display persistence is being selected (page 
34) 

Language Q I want to switch the language from Chinese to 
English (or vice versa). 

 A Press the menu key and select “FUNCTION” 
or “ ” using the Up/Down keys, then 
press F3 (Language/ ). See page 34 for 
details. 
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SPECIFICATIONS 
 

Conditions for 
specifications 

The following specifications are applicable when 
these two conditions are met: 

 The GDS-122 has been powered up for at least 
30 minutes, during which temperature 
fluctuation is no more than 5 degrees Celsius. 

 The probe attenuation is set to X 10. 

Oscilloscope specifications 
 

Sampling Mode Normal, Peak detection, Average 

 Rate 100 MSa/s  

Input Coupling DC, AC 

 Impedance 1MΩ± 2% in parallel with 20pF± 3pF  

 Probe 1X, 10X, 100X, 1000X 

 Max. Input 400V (peak)  

 Channel delay 150ps (typical) 

Horizontal Sampling rate 10S/s～100mS/s  

 Interpolation (sin x)/x 

 Record length 6K points on each channel 

 Scanning speed 5ns/div～5s/div, 1-2.5-5 step 

 Sampling rate / 

relay time accuracy 

±100ppm (time interval ≥ 1ms) 

 Interval (△T) 

accuracy (full 

bandwidth) 

Single: ±(1 interval time +100ppm×

reading+0.6ns) Average >16 : ±(1 

interval time +100ppm×reading+0.4ns) 

Vertical A/D converter 8 bits resolution (2CH simultaneously) 

 Sensitivity 5mV/div～5V/div（at input） 

 Displacement ±50V(500mV～5V),±1V(5mV～200mV) 

 Bandwidth 20M 

 Single Full bandwidth 

 Low frequency ≥5Hz（at input, AD coupling, -3dB） 

 Rise time ≤17.5ns (at input, typical) 
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 DC accuracy ±5% (DC gain) 

 DC accuracy (avg) Avg >16: ±(5% rdg + 0.05 div) for △V 

Trigger Sensitivity CH1 and CH2: 1div(DC～full bandwidth) 

DC coupling: ≥ 50Hz. 

 Trigger level ±6 divisions from the screen center 

 Level accuracy ±0.3 div (typical, rise/fall time ≥ 20ns) 

 Displacement 655div (pre-trigger), 4div (post- trigger) 
 50% level setting Input signal frequency ≥ 50Hz (typical) 
 Trigger sensitivity 2 div of peak-to-peak (video trigger) 
 Signal system NTSC, PAL, SECAM (any frequency) 

Measurement Cursor △V and △T between cursors 

 Automatic Peak-to-peak, average, root mean 

square, frequency, and cycle. 

Probe  1X position 10X position 

 Bandwidth ≤ 6 MHz (DC) Full bandwidth (DC) 

 Attenuation rate 1: 1  10: 1 

 Compensation 10pf～35pf 10pf～35pf 

 Input impedance 1MΩ±2％ 10MΩ±2％ 

 Input impendence 85pf～115pf 14.5pf～17.5pf 

 Input voltage 150 V DC 300V DC 

Multimeter specifications 
 

VDC Input impedance 10MΩ 

 Max input 1000V (DC or AC peak-to-peak value) 

 Accuracy ±1%±1 digit 

 Resolution 400mV range: 100uV 

4V range: 1mV 

40V range: 10mV 

400V range: 100mV 

VAC Input impedance 10MΩ 

 Max input 750V(AC, virtual value) 

 Frequency range 40Hz~400Hz 

 Display Virtual value of sine wave 

 Accuracy ±1%±3 digits 

 Resolution 4V range: 1mV 

40V range: 10mV 

400V range: 100mV 

DCA Accuracy 40mA range: ±1%±1 digit 

400mA range: ±1.5%±1 digit 
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20A range: ±3%±3 digits 

 Resolution 40mA range: 10uA 

400mA range: 100uA 

20A range: 10mA 

ACA Accuracy 40mA range: ±1.5%+3 digits 

400mA range: ±2 %±1 digit 

20A range: ±5%±3 digits 

 Resolution 40mA range: 10uA 

400mA range: 100uA 

20A range: 10mA 

Resistance Accuracy 400Ω range: ±1%±3 digits 

4kΩ~4MΩ range: ±1%±1 digit 

40MΩ range: ±1.5%+3 digits 

 Resolution 400Ω range: 0.1Ω 

4kΩ range: 1Ω 

40kΩ range: 10Ω 

400kΩ range: 100Ω 

4MΩ range: 1kΩ 

40MΩ range: 10kΩ 

Capacitance Accuracy ±3%±3 digits 

 Resolution 51.2nF range: 10pF 

512nF range: 100pF 

5.12uF range: 1nF 

51.2uF range: 10nF 

100uF range: 100nF 

Diode Reading range 0V~1.5V 

Continuity Threshold < 30Ω 

General specifications 
 

 Resolution 320 (horizontal) ×240 (vertical) pixels 

 Color 4096 colors 

Power Consumption < 6W 

 Supply 100V~240V AC, 50/60Hz 

 DC input 8.5VDC, 1500mA 

Environment Operating Temperature: 0  to  40 °C(32  to  104 °F) 

Relative humidity: < 75% 

 Storage Temperature: -20  to  60 °C(-4  to  140 °F) 

Relative humidity: < 75% 

Mechanical Dimension 18 cm× 11.5cm× 4cm 
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 Weight 645g 
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Declaration of Conformity 
 

We 

GOOD WILL INSTRUMENT CO., LTD. 

(1) No.7-1, Jhongsing Rd., Tucheng City, Taipei County, Taiwan 

(2) No. 69, Lu San Road, Suzhou City (Xin Qu), Jiangsu Sheng, 

China 

declare, that the below mentioned product 

Type of Product: Handheld Digital Storage Oscilloscope & 

Multimeter 

Model Number: GDS-122 

is herewith confirmed to comply with the requirements set out in 

the Council Directive on the Approximation of the Law of Member 

States relating to Electromagnetic Compatibility (89/336/EEC) and 

Low Voltage Directive (73/23/EEC). 

For the evaluation regarding the Electromagnetic Compatibility and 

Low Voltage Directive, the following standards were applied: 

◎ EMC 

EN 61326-1: Electrical equipment for measurement, control and 

laboratory use  –– EMC requirements (1997 + A1:1998 + A2:2001 + 

A3:2003) 

Current Harmonics 

EN 61000-3-2: 2000 + A2:2005 

Voltage Fluctuations 

EN 61000-3-3: 1995 + A1:2001 

------------------------- ------------------------- 

------------------------- ------------------------- 

◎ Safety 

Low Voltage Equipment Directive 73/23/EEC 

Safety Requirements 

IEC/EN 61010-1: 2001 (2nd Edition) 
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AC coupling 

trigger ............................................31 

vertical ...........................................23 

ACA multimeter ................................90 

specifications ............................... 103 

AC-DC adaptor ...................................8 

acquisition ..........................................33 

short cuts .......................................59 

system status .................................36 

ACV multimeter ................................88 

specifications ............................... 102 

addition, math mode ........................38 

auto ranging 

impedance multimeter ................93 

voltage multimeter .......................89 

auto trigger mode..............................30 

AUTO trigger status .........................26 

automatic measurements .................40 

shortcuts ........................................58 

Autoset ...............................................17 

capacity multimeter .....................97 

continuity, multimeter .................96 

diode, multimeter .........................95 

impedance measurement ............93 

voltage multimeter .......................88 

average acquisition mode ................33 

application ....................................48 

background color, PC software .......70 

battery level .......................................15 

calibration ..........................................51 

capacitance measurement, 

multimeter .....................................97 

specifications ............................... 103 

carry, interface setting ......................67 

carrying case ........................................8 

caution symbol ....................................3 

CD-ROM ..............................................8 

channel 

edge trigger ...................................29 

on/off ............................................. 22 

video trigger source ..................... 32 

Chinese, language selection ............. 34 

contents of package............................. 8 

continuity, multimeter...................... 96 

specifications .............................. 103 

coupling 

system status ................................. 36 

trigger ............................................ 31 

vertical ........................................... 23 

cursor measurement 

PC software ................................... 78 

short cuts ....................................... 58 

time ................................................ 41 

voltage ........................................... 42 

cycle rms, automatic measurement 40 

data point, storing ............................. 80 

data table, PC software ..................... 80 

DC coupling 

trigger ............................................ 31 

vertical ........................................... 23 

DCA multimeter ............................... 90 

specifications .............................. 102 

DCV multimeter ................................ 88 

specifications .............................. 102 

default settings .................................. 54 

delta measurement 

capacitance multimeter ............... 98 

current multimeter ....................... 91 

impedance multimeter ................ 94 

voltage multimeter ....................... 89 

diode measurement, multimeter ..... 95 

specifications .............................. 103 

display 

acquiring snapshot ....................... 68 

brightness adjustment ................. 15 

overview ........................................ 18 

settings........................................... 34 

shortcuts ........................................ 59 
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division, math mode ........................ 38 

dot drawing ....................................... 34 

edge trigger 

auto mode ..................................... 30 

coupling mode ............................. 31 

mode ............................................. 30 

normal mode ................................ 30 

single mode .................................. 30 

EN61000 ........................................... 105 

EN61010 

declaration of conformity ......... 105 

measurement category .................. 4 

pollution degree ............................. 5 

EN61326-1 ....................................... 105 

English, language selection ............. 34 

environment 

operation ......................................... 4 

specifications .............................. 103 

storage ............................................. 5 

ERR mode, multimeter .................... 99 

extension module 

capacitance multimeter ............... 97 

current multimeter ...................... 91 

package ........................................... 8 

factory settings .................................. 54 

FAQ .................................................... 99 

ERR mode, multimeter ............... 99 

magnification ............................... 99 

no waveform .............................. 100 

powering up ................................. 99 

slow update, multimeter .......... 100 

slow update, oscilloscope ......... 100 

unstable waveform ...................... 99 

field trigger, video ............................ 32 

freezing measurement 

capacitance multimeter ............... 98 

continuity multimeter ................. 96 

current multimeter ...................... 91 

diode multimeter ......................... 95 

impedance multimeter ................ 94 

voltage multimeter ...................... 89 

frequency, automatic measurement40 

front panel overview ........................ 10 

grid color, PC software .................... 71 

grid, PC software .............................. 71 

ground symbol.................................... 3 

help, PC software ............................. 85 

Hf Rjc ................................................. 31 

horizontal 

adjusting position ...................19, 24 

adjusting scale .........................18, 25 

scale vs trigger status .................. 26 

short cuts ...................................... 59 

specifications .............................. 101 

system status ................................ 36 

impedance, multimeter.................... 93 

specifications .............................. 103 

installing PC software ...................... 63 

inverting channel ............................. 23 

language ............................................ 34 

PC software .................................. 72 

LF Rjc ................................................. 31 

line data, PC software ...................... 71 

line trigger, video ............................. 32 

list of features ..................................... 9 

magnification, vertical ..................... 24 

manual ranging 

current multimeter ...................... 91 

impedance multimeter ................ 94 

voltage multimeter ...................... 89 

manual, overview of ........................ 12 

math mode ........................................ 38 

shortcuts ....................................... 58 

system status ................................ 36 

mean voltage, auto measurement .. 40 

multimeter 

activating ...................................... 87 

capacitance measurement .......... 97 

continuity measurement ............. 96 

current measurement .................. 90 

diode measurement..................... 95 

ERR mode ..................................... 99 

impedance measurement ........... 93 

specifications .............................. 102 

switching to oscilloscope ............ 87 

voltage measurement .................. 88 

warning message ......................... 87 

multiplication, math mode .............. 38 

noisy signal, viewing ....................... 48 

normal trigger mode ........................ 30 

operation environment ...................... 4 

OSC option key................................. 61 
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oscilloscope 

specifications ............................... 101 

switching to multimeter ..............15 

package contents .................................8 

PC software 

activation .......................................66 

cursor measurement ....................78 

help ................................................85 

installation .....................................63 

overview ........................................62 

package ............................................8 

printing out ...................................83 

saving waveform ..........................80 

screen overview ............................70 

uninstall .........................................65 

version ...........................................85 

viewing waveforms .....................73 

peak detect acquisition mode ..........33 

application ....................................47 

period, automatic measurement .....40 

persistence setting .............................34 

application ....................................49 

pk-pk voltage, automatic 

measurement ................................40 

point data, PC software ....................71 

position 

horizontal ......................................24 

math mode ....................................39 

shortcuts ........................................61 

time cursor ....................................42 

trigger ............................................27 

vertical ...........................................22 

voltage cursor ...............................43 

waveform, PC software ...............74 

xy mode .........................................47 

power supply 

safety instructions ..........................4 

specifications ............................... 103 

power up, faq.....................................99 

powering up ......................................15 

print out, PC software ......................83 

probe 

adjusting display magnification .16 

adjustment tool ...............................8 

calibration .....................................52 

package ............................................8 

setting attenuation ....................... 16 

specifications .............................. 102 

Ready trigger status .......................... 26 

recalling 

default settings ............................. 54 

waveforms from GDS-122 ........... 56 

waveforms, PC software ............. 82 

resetting trigger level ........................ 28 

run trigger .......................................... 27 

sample acquisition mode ................. 33 

saving 

shortcuts ........................................ 60 

waveforms in PC software .......... 80 

waveforms inside GDS-122 ......... 55 

scale 

horizontal ...................................... 25 

math mode .................................... 39 

vertical ........................................... 22 

waveform, PC software ............... 75 

xy mode ......................................... 47 

zoom .............................................. 46 

Scan trigger status ............................. 26 

self calibration ................................... 51 

SET1/2, automatic measurement ..... 40 

signal peak, viewing ......................... 47 

single trigger mode ........................... 30 

slope, trigger ...................................... 29 

snapshot, display .............................. 68 

software version ................................ 85 

specifications 

multimeter .................................. 102 

oscilloscope ................................. 101 

stop trigger ......................................... 27 

STOP trigger status ........................... 26 

storage environment ........................... 5 

subtraction, math mode ................... 38 

synchronization, video trigger ........ 32 

system status ..................................... 35 

shortcuts ........................................ 60 

test lead ................................................ 8 

threshold, continuity multimeter .... 96 

tilt stand ............................................. 16 

time cursor ......................................... 41 

Trig'd trigger status .......................... 26 

trigger 

adjusting level .............................. 27 
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auto mode ..................................... 30 

channel, edge trigger ................... 29 

coupling mode ............................. 31 

mode ............................................. 30 

normal mode ................................ 30 

run/stop ........................................ 27 

shortcuts ....................................... 57 

single mode .................................. 30 

slope .............................................. 29 

source channel, video .................. 32 

specifications .............................. 102 

status icons ................................... 26 

status vs horizontal scale ............ 26 

sync, video trigger ....................... 32 

system status ................................ 36 

UK power cord ................................... 6 

USB driver installation ..................... 66 

variations, viewing ........................... 49 

vector drawing .................................. 34 

vertical 

adjusting position ...................19, 22 

adjusting scale .........................18, 22 

inverting channel ......................... 23 

selecting coupling mode ............. 23 

selecting magnification ............... 24 

shortcuts ....................................... 57 

specifications .............................. 101 

system status ................................ 36 

video trigger 

field trigger................................... 32 

line trigger .................................... 32 

source channel ............................. 32 

sync ............................................... 32 

voltage cursor ................................... 42 

warning message, multimeter ........ 87 

warning symbol .................................. 3 

xy mode ............................................. 46 

system status ................................ 36 

zoom waveform 

system status ................................ 36 
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